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EXAMPLE : CREATING AN ADDRESS LIST

1. On a new document, type the title of the Address List and

fomat it like Bold, Underline, Italics.

2. Select "Table" from the menu bar and then "Insert Table".

3. Select the Number of Columns and Rows and click OK button

from the dialogue box.

Move the cursor in the respective rows and column; then type the

names, addresses etc.
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EXAMPLE: DESIGNING A LOGO 

Introduction 

A logo is an image which represents a company or its product. Its

function is to create a memorable, recognizable impression on the

mind of a potential client or customer.
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Types of logos 

There are three basic types of logos, which can be used alone or

combined within one design:

· illustrative logos (a logo which clearly illustrates what your

company does), 

· graphic logos (a logo that includes a graphic, often an abstraction,

of what your company does), and 

· font-based logos (a text treatment which represents your

company)

Qualities of a good logo 

1. Simplicity: 

2. Experimentation. One has to experiment with the fonts, sizes

and shapes. 

3. Colour choice. Choose colours that have meaning in relation to

the client's needs. 

4. Logo type. Determine whether it is illustrative, graphic or font-

based.

Objectives 
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Activity : Font based-logos

!. Open MS Word,

2. Enter any two letters of your choice in a new Document. In this

case, I have used M and W because they are the initials of the

author's names, 

3. Select and change the font style of "M" to "Forte" and size 90

and "W" to "Ravie" and size 72,

4. Change the font colour of "W" to red to create contrast when

later combined,

5. Copy and Paste the letters in MS. Paint. This is done in order to
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5. Copy and Paste the letters in MS. Paint. This is done in order to

combine them as images,

6. Combine the two letters creatively to create a logo,

7. Save the file as "Logo.bmp", 

8. Open  the file in MGI PhotoSuite,

9. Using the Magic Wand tool, click on a letter to select it. Drag it

to the blank working space,

10. Combine as you wish to create a logo,
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11. Using the Wang magic tool, click on the letters while holding

down the Shift key. Click on the background too and drag,

12. Experiment with various combinations of the same letters.
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12. Experiment with various combinations of the same letters.

Related link:

http://graphicdesign.about.com/library/weekly/aa102600a.htm
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EXAMPLE: CREATING A NEWSLETTER OR BROCHURE

1. On a new document, type the title of the article inside

borders.

2. Move the cursor down outside the title borders.

3. Type the article up to the end.

4. Highlight the whole article without highlighting the title.

5. Select "Format" from menu bar and select "Columns".

6. A column dialogue box appears and select the type of

columns you want and click OK button.

7. Move the cursor to position where you want to insert the

picture.

8. Select "Insert" from the menu bar; select "Picture" and then

"From File".

9. A dialogue box appears, then select the filename where the

picture is stored and click "Insert" button.

10. Adjust the size of the picture by clicking on it and then moving

the squared patterns on its borders.

11. Insert a square symbol at the end of the article by selecting

"Insert"; select "Symbol" and a dailogue box of symbols will

appear.
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appear.

12. Under Font in the dialogue, select "Wingdings" and then

select the squared symbol.

13. The square symbol marks the end of the article.

Click here to see a Newsletter example
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PAGE PROPERTIES

Page Formatting 

Page format results from the combined effect of document

formatting and section formatting.  Document formatting includes

paper size, margins, etc., hence affecting the whole document. 

Section formatting on the other hand, includes the placement of

headers and footers, the number of columns, line numbering etc.,

hence affecting all pages.

In this course, the page formatting will include: 
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In this course, the page formatting will include: 

- Controlling page breaks 

- Adding page numbers to your document 

- Adding headers and footers (running heads) 

- Changing size of margins 

- Changing paper size and type.

When you format pages MS Word for Windows does not display

the formats in the normal editing screen.  To view the formats,

(page numbers, running head position and margins) use the PRINT

PREVIEW (Alt, F, V,) command.

Page breaks

Soft and hard page breaks: 

You do not need to divide your text into pages as you type

because MS Word for Windows does that for you. It automatically

inserts a page divider each time you reach the end of the page in

much the same way as it wraps text at the end of the line. The

page dividers inserted are called soft page breaks, and are placed

at the end of all text that fits on one page.

Such page breaks are called soft because their location is likely to

change as you add or delete text.  MS Word for windows

continually reformats your document from page to page, displaying

on the status line the page number on which the cursor is found.

25/10/2011 Creating Learning Networks for African…

D:/cd3wddvd/NoExe/…/meister10.htm 18/66



Worksheets

Columns & Rows

Charts

Examples

Refraction of

Light

Solving

Polynomial

Equations

Workers'

Database

Base Converter

Activities

Links

Databases

Tutorial

Introduction

Example

Periodic Table

on the status line the page number on which the cursor is found.

However, you may decide where your own page breaks by inserting

a hard page break or by using the menu to paginate the

document.  The location of a hard page break will not change

regardless of the changes you make to your document.

To insert a hard page break using the keys: 

Select the first character of the new page and press Ctrl + Enter. A

line of dots appears across the screen at the page break with the

word page break in the middle of the line.

To insert a page break using the menu. 

1. Position the insertion point where you want page break, and

then choose Insert Break. 

2. Select on Page Break. 

3. Choose OK.

Removing page breaks 

To remove a page break, select the page break and tap the delete

key.  If you used Page Break before in Format Paragraph, turn off

Page Break Before and then choose OK.

Header and footers 

This is text that appears on every page of selected pages of a
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This is text that appears on every page of selected pages of a

document.  Such repeated items are called headers when they

appear in the top margin of the page, and footers when they

appear in the bottom margins.

A header or footer may contain page numbers, then system date

or time.

Creating a header or footer 

1. Choose View Header/Footer.  A dotted rectangle labeled header

or footer is displayed on the screen.  Type the header in this box

and select close when finished.

Below the box is the header tool bar.  Placing the cursor on each

tool gives the function of the tool.

Header/Footer options 

These are under Page setup. Go to Page setup in the

Header/Footer pane, and click on the 8th tool on the

Header/Footer pane.

Different first page: 

Check this option if you do not want the Header/Footer to appear

on the first page of the document.

Different odd and even pages: 

25/10/2011 Creating Learning Networks for African…

D:/cd3wddvd/NoExe/…/meister10.htm 20/66



HTML Editors

Tutorial

Basic html

Netscape

Composer

Examples

Teaching

Syllabus

Teachers' Notes

Subject Website

Lists

Students

Website

Art 

Principles of Art

Elements of Art

Coloured Pencil

Paintings

Pastel Paintings

Book cover

Different odd and even pages: 

This is used to specify different Headers/Footers text to appear on

Odd and Even numbered pages. This option affects the entire

document regardless of the number of sections.

Distance from edge: 

Distance in inches between the Header/Footer and the margins of

the page.

Choose Close when finished.

When you want to include page numbers, date or time in the

header or footer, use the icons that are across the Header/Footer

pane.

To select any icon in the pane, click on the icon

Deleting headers and footers 

1. Choose view, Header/Footers 

2. Select the Header/Footer in the Header/Footer box and tap the

delete key and then choose close.

Page numbering 

Page numbers are typically a part of a header or footer. MS Word

for Windows provides two ways for numbering pages:
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for Windows provides two ways for numbering pages:

- Automatic page numbering using the Insert Page Numbers

command. 

- Including page numbers in the Header/Footer using the view

Header/Footer command.

Automatic page numbering 

The Insert Page Numbers command using automatic Page

numbering as your header of footer. 

1. Choose Insert Page Numbers. 

2. Select a top or bottom page Number position. 

3. Select alignment and specify the where at the top or bottom the

page numbers should be inserted. 

4. Select format and specify the format for the page numbers i.e.

Arabic, Alphabetical, Romans. 

5. Choose OK to insert the page numbers.

Page numbering in Header/Footer 

The View Header/Footer command is convenient if you want text

in addition to the page number for example (Page 1), and if you

want the page number in a specific format like bold or italics.

1. Choose View Header (Alt, E, H). 

2. Select Create Header or Footer in which you want to add page
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2. Select Create Header or Footer in which you want to add page

numbers. 

3. Position the insertion point where you want the page number to

appear, and then select the page number icon. 

4. Select the Header/Footer text and apply the required formats to

the page number and choose Close when finished.

Number format 

Select the style of numbering from the field. MS Word for Windows

provides five number formats for page numbering. Choose the one

you want in the field of number format.  The formats are: 

  

 

Option Example

Arabic 1,2,3..()

Roman Uppercase I, II, III

Roman lowercase  i, ii, iii

Alphabetic Uppercase A, B, C

Alphabetic lowercase a, b, c

To change number format; 

1. Choose Insert Page numbers. 

2. Choose Format and then select the page number format you

want. 

3. Choose OK.
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3. Choose OK.

Start at: 

This field indicates the starting number if the first page is too be

given a number other than 1.

Removing page numbers for headers and footers 

1. Choose View Header/Footer. 

2. Select the header/footer that has the page number and tap the

delete key. 

3. Choose OK when finished.

Removing page numbers for automatic page numbering 

Choose Edit, Undo Page Numbering.

Paper size and margins 

Ms Word for Windows is preset to print on 8.5 by 11.69 paper,

with 1 top and bottom margins and 1.25 left and right margins.  It

is important that MS Word for Windows knows the right size of

paper that it is going to print on so that it breaks your pages in the

right positions.  You can change these with the following

procedures:

1. Choose the File Page setup command. 
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1. Choose the File Page setup command. 

2. Select the button for margins and type the measurements you

want on the fields of:

Top  for the top margin size 

Bottom for the bottom margin size 

Left  for the left margin size 

Right   for the right margin size 

Page length for the length of paper 

Width  for the paper width

You can click on the up and down arrow keys on all options to

increase or reduce the margins. 

3. Choose the Button for paper size and set the size and page

orientation.  Selecting default after making the required settings

saves the setting to be used for every document. 

4. Select the paper source.  This is for the laser printer. 

5. Choose OK to accept all the settings that have been made.

 

Previous: Working with text Next: Printing
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PRINTING A DOCUMENT

MS Word for Windows allows you to print documents to a printer. 

Before printing you can prepare your document by setting some

options set the number of copies per page, the pages to be

printed, the name of the printer to be used etc.

Preparing a document for printing: 

1. Choose File ---> Print 

2. Select Options. 
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The following options will be displayed:

Draft: 

Prints the document without special character formats.

Copies: 

MS Word for Windows prints the number of copies entered in this

field, a whole set is printed first, then repeated for each copy

requested.

Pages: 

Select the pages to be printed.

All: 

The whole document will be printed.

Selection: 

Only the highlighted text is printed.

From: 

Beginning page number for the page you want to print.

Paper feed: 

Selects the source of paper manually.  The printer stops after
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Selects the source of paper manually.  The printer stops after

printing each page and waits for you to press Y after changing the

paper.

Continuous: 

The printing is done without pausing for paper changes at the end

of each page. 

  

Printing to printer: 

After setting the options in the File Print command, press Enter or

choose Print to get a hard copy of your document.  The printer

must be turned on, otherwise MS Word for Windows displays the

message: Printer not ready.

Previous:  Page Properties                        Next:  Quitting Microsoft

Word
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Choose File ---> Exit or Press Alt-F4. 

If there are unsaved changes, MS Word for Windows will ask you to

save them, lose them or cancel the command by selecting either

Yes, No or Cancel respectively.

Previous: Printing a Document
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EXAMPLE: REPEAT PATTERNS

Pattern is an underlying structure that organizes surfaces or structures in a

consistent, regular manner. Pattern can be described as a repeating unit of

shape or form, but it can also be thought of as the "skeleton" that

organizes the parts of a composition.  

Objectives 

To enable the learners discover and exploit the patterns through nature

and the objects around them.  

Use ICT as a different way in which their patterns can be reproduced. 

Rationale 

This will enable the learner to gain skills in creating patterns from objects

he/she is familiar with to form a harmonised piece of artwork. 
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Qualities of a Good Repeat Pattern

1. A Repeat Pattern must have an objective and an aim.  

2. It should solve a problem of it should be useful in one aspect or

another.  

3. It should be able to repeat or flow. 

Sources of inspiration for patterns can be:  

     Animal skins (domestic and wild)  

     Flowers  

     Fruits and plants  

     Tools  

     Musical Instruments (traditional and modern)  

     Human activities like hunting, digging, etc. 

Artists create patterns and textures using lines and shapes. 

Activities

1. Students go out and draw any two types of fruits they wish to choose.

These sketches are made in their sketch books in order to keep a record of

their original work.  

2. They can draw the basic shapes of the fruits applying textures and

tones.  
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3. They could include the leaves to give their drawing a background.  

4. After this, they can select from what they have drawn and make a neat

and final drawing on a squared piece of paper. This can be 12cm by 12cm

and is usually called a motif.  

This paper is to help them in achieving accurate dimensions when

repeating their pattern. 

Hand made Repeat Pattern

1. On a large piece of paper, they can accurately divide it into 12cm by

16cm portions using a faint pencil.  

2. After this, they can tress their motif drawings into the small portions on

the large paper. 

Remember to rub out all the pencil marks when all is done.  

 

Using Word to make a Repeat Pattern

1. Using a scanner, scan the motif and save it as "Motif.bmp".  

2. Open the file from MGI PhotoSuite.  

3. From Edit menu, click on Select All.  

4. From the Edit menu, click on Copy.  

5. Open MS. Word.  
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6. From the Edit menu, click on Paste. 

7. Repeat the Paste action four times. 
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8. Click and drag the images aligning them next to each other. 
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image

9. Holding down the Shift key down, click on each image you have pasted

to select them all at once.  

10. Still holding the Shift key, right click the mouse and select Grouping

and click Group while pointing to the selected images. 
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11. Repeat the procedures the number of times you want. 
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Changing the colours of the image 

1. Scan the motif in the Gray mode.

  

2. Repeat the steps above. 
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3. Print out a copy of your work using a coloured printer. 

Note: Remember to save your work.

Exercise:  

Make a few quick drawings of a flower to use in the motif. Experiment with

different textures and shades on your flower drawings and then transfer

them onto the motif.  

Repeat the motif on a larger piece of paper, preferably coloured. 

Or 

A local Art museum has requested you to design new curtains for their
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WORD PROCESSING TUTORIAL

INTRODUCTION TO MICROSOFT WORD

To start MS Word for Windows, do the following: 

Using the mouse, click the Start button, then click Programs,

Microsoft Office folder (if it exists) and the MS Word icon. If folder

doesnt exist, you should be able to see the MS Word icon. 
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The Ms Word for Windows Screen:

The MS Word for Windows Screen consists of the following major

features, some of which may not be displayed when you start MS

Word for Windows.

a) The title bar which displays the name of the application and

name of the active document in the window. 
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b) The applications Control Menu box at the top left corner of the

MS Word for Windows window. 

c) Maximize, minimize and close Control buttons at the top right

corner of the MS Word for Windows window. 

d) The Workspace of the application onto which several document

windows can be opened. . 

e) The Menu Bar that displays menu names.  When there is no

document open, only the File pull-down menu is accessible. 

f) The ribbon is a graphic bar across the top of MS Word for

Windows.  It shows icons for character formatting, font box and

point size box of selected box or text at the cursor.  When no

document window is open, the ribbon is gray (that is, non-of the

icon is available for use). 

g) The Ruler is an on-screen helper across the top of a document

window, for formatting paragraphs, adjusting columns widths in

tables, and adjusting page margins.  It consists of the style box

icons for paragraph formatting.  It can be turned on and off. 

h) Status bar at the bottom of the MS Word for Windows window

that display either status information (that is, position of the

insertion point in the window and modes) or messages describing

the action of any highlighted command in any active menu. 

i) Scroll bars are tools for moving the document in the window

using the mouse.  The scroll boxes inside the scroll bars indicate
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your approximate location in the document vertically and

horizontally.  At the top and bottom of the scroll bar are scroll

arrows. 

j) Tool Bar is below the menu bar.  It has pictures [called tools or

icons] that act as short cuts to some of the application functions. 

Placing the cursor on any of the icons displays a tool tip that tells

you the name or description of the icon.

Note: 

The ruler, ribbon and the status bar can be turned on and off using

the view command.

Keyboard Skills and Some Important Keys:

You are reminded that the keyboard is typematic -- a key will

repeat if held down. Therefore avoid holding down keys for a long

time.

Choosing and carrying out commands is the basis for instructing

MS Word for Windows to act on a document. You can choose

commands using the keyboard or the mouse. In this course we

shall concentrate more on using the mouse.
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To Select a Command Using a Keyboard:

Use Alt plus the underlined letter of the command. 

For example: Alt + F select the command File from the menu. 

Using the arrow keys highlight the required command and press

enter.

Some keys are of special importance, these are indicated below:

-Alt: Turns on/off the menu. 

-Backspace: Erases character to the left of the cursor. 

-Enter: Ends a paragraph or sends a command to the computer. 

-Caps Lock: Toggles between upper case and lower case. 

-Shift: Used to get the upper characters on the keys, or upper

case/lower case characters when the Caps lock is off/0n. 

-F1: Help 

-Shift F1: Allows you to get help on any command you want.

To Select a Command Using the Mouse: 

In MS Word for Windows, if you have a pointing device (for

example, mouse), you need not use the keyboard to select a

command.

To activate any menu using the mouse, point to the menu name

and then click the left button of the mouse. Then click the
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WORKING WITH TEXT

Entering Text 

Text is entered at the position of the cursor, called the Insertion

Point (that is, a vertical blinking bar indicates where text to be

typed and items to be inserted will be inserted). At the right

margin, Word Wrap takes care of words that do not fit such that a

whole word is not broken up, but is shifted to the next line (unless

hyphenation is on).
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The ENTER key ends a paragraph. Short lines may be ended with

Shift-Enter.

Insert or/Over type mode 

When you load MS Word for Windows, you are said to be in insert

mode in which case characters at the right of the cursor shift to the

right to leave space for the in coming characters.  This mode can be

turned off by pressing the Insert key that switches you to overtype

mode.  The word OVR will appear on the status line.  In overtype

mode, a character typed in replaces the one at the cursor. 

Overtype is helpful in correcting certain kinds of mistakes.

Editing text 

This includes making corrections in a document, deleting unwanted

text, inserting omitted text, moving and copying text from one

place to another.

Deleting text 

Backspace - deletes character to the left of the insertion point. 

Delete - deletes character to the right of the insertion point.

Holding delete while pressing Backspace or Delete deletes the

whole word near the cursor e.g:

- Ctrl-Backspace - deletes word to the left of the insertion point. 
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- Ctrl-Delete - deletes word to the right of the insertion point.

Selecting text 

MS Word Windows is built on the select and then do model. 

Before you can change any part of a document or any setting in a

dialogue box, you must select text and then choose the

appropriate action.

Cutting and pasting text allows you to move/copy contents from

one place in a document to another and from one document to

another.  You can transfer contents between MS word for

Windows documents and also between MS Word for Windows

documents and documents of other Window applications.

The information moves through the Clipboard, a temporary

storage area designed to accept text and graphics from all

Windows programs for transportation from one place to another.

Cutting/Copying a selection to a clipboard 

 1. Select text. 

 2. Choose Edit Cut 

 3. To copy, choose Edit Copy 

The text will replace any text previously found on the clipboard.
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Pasting text from clipboard

1. Position the insertion point where you want to insert Clipboard

contents. 

2. Choose Edit Paste

Moving within a document with the Move key (F2) 

The Move key does not put contents, onto the clipboard. 

1. Select the contents you want to move. 

2. Press F2.

A prompt: "Move to where?" Will appear on the Status line.  If you

want to cancel before you move, press ESC.

3. Move the insertion point to the new location. 

4. Press ENTER to get the text in the location.

OR:

1. Position the insertion point at the destination for the move. 

2. Press F2.

A prompt: "Move from where?" will appear on the Status line.

3. Select the contents you want to move. 

25/10/2011 Creating Learning Networks for African…

D:/cd3wddvd/NoExe/…/meister10.htm 54/66



HTML Editors

Tutorial

Basic html

Netscape

Composer

Examples

Teaching

Syllabus

Teachers' Notes

Subject Website

Lists

Students

Website

Art 

Principles of Art

Elements of Art

Coloured Pencil

Paintings

Pastel Paintings

4. Press ENTER to get text in the location.

Copying text within a document with the Copy key (Shift-F2) 

1. Select the contents you want to copy. 

2. Press Shift-F2.

A prompt: "Copy to where?" Will appear on the Status line.  If you

want to cancel before you move, press ESC.

3. Move the insertion point to the new location. 

4. Press ENTER to get a copy of the text in the location.

Copying/Moving between documents 

1. Open both documents. 

2. Use one of the methods listed above for moving within

document.  To move between documents, click in the document

window or press Ctrl-F6.

Character formatting 

Character formatting determines how characters will appear on the

screen and in print and enables you to determine the size and the

appearance of the selected text. 

The following shows examples of available formats:
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- Bold 

- Italics 

- Underline 

- Double-underline 

- Strike-out 

- lowercase 

- UPPERCASE 

- Increased font 

- Superscript (e.g. 8th ) 

- Subscript (e.g. logx )

You can format existing text or format as you type. 

To format existing text using the icons on the ribbon

The  ribbon, which can be turned on and off using the View

command, consists of icons for formatting characters.

 1. Select text. 

 2. Click the icon on the  ribbon representing the kind of format

you want.

Formatting paragraphs 

Formatting paragraphs involves alignment, indentation, line
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spacing, paragraphs spacing keep together, keep together, keep

with next, page break before, line numbering, borders and style.

Alignment 

Using this feature, you can align multiple lines of text on the

right/left margins, on both margins, or centre it between margins. 

This means that the text lines up with the paragraph boundaries.

There are four types of alignment you can use left, right, centre

and justified.  See below for several examples, noting that 'justify'

spreads the text across the line:

To enhance chances of success, financial institutions must create

advisory services to scrutinize and advise borrowers on prudent

financial management, book-keeping, purchasing and marketing

techniques (left alignment).

To enhance chances of success, financial institutions must create

advisory services to scrutinize and advise borrowers on product

financial management, book-keeping, purchasing and marketing

techniques (centre alignment).

To enhance chances of success, financial institutions must create

advisory services to scrutinize and advise borrowers on product
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financial management, book-keeping, purchasing and marketing

technique (right alignment).

Left Alignment: 

Each line is even with the left paragraph boundary.  The right ends

of the lines are uneven.

Centre Alignment 

Each line is centered between the left and right paragraph

boundaries.  Both ends of the lines are uneven.

Right Alignment: 

Each line is even with the right paragraph boundary.

Justify Alignment: 

Each line is even with both the left and right paragraph

boundaries.  Each full line is padded with extra space between

words to make the right end of the line even with the right

paragraph boundary.

Indenting paragraphs 

A paragraph indent is the distance between the paragraph

boundaries and the page margins.  The amount of indentation

controls the width of a paragraph and the placement of its
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horizontal boundaries.

Paragraph spacing 

Paragraph spacing is the amount of blank space used as a visual

break between two paragraphs, or space preceding headings, lists,

tables and pictures.

In words, you control and adjust paragraph spacing by adding

space before and after a paragraph. If one paragraph has added

space after and the next paragraph has added space before, the

amount of space between them is the total of the two amounts of

added space.

Line spacing 

Line spacing is the amount of blank spacing between the lines of a

paragraph.  MS Word for Windows has icons on the ruler for

single-spaced, double-spaced, and one-and-one-half spaced, but

you can set any amount of spacing you want.

The following units are used as measurements: 

 

Lines (li) Points (pt)

- 1 li (single spacing) 
- 12 pt (approximately single

spacing) 
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- 2 li (double spacing) 

- 3 li (triple spacing) 

- 1.5 li (one-and-one-half line

spacing).

- 24 pt (approximately double

spacing0 

- 18 pt (approximately one-and-

one-half).

Other units (in, cm, pi) 

For example, 0.167 in, 0423 cm, and 1 pi are all approximately

equal to one line at 6 lines per inch.

You can also increase the number of lines for any selected line

spacing option using the AT Box opposite the line spacing box.

Click on the up arrow to increase the number of lines or the down

arrow to decrease the number of lines.

For all paragraph formats the preview box shows how the text will

be appear if the format is applied. 

Previous:  Introduction Next:    Page Properties
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EXAMPLE : CREATING A TIME TABLE

1. On a new document, type the title of the Timetable and fomat

it e.g. Bold, Underline, Italics.

2. Select "Table" from the menu bar and then "Insert Table".

3. Select the Number of Columns and Rows and click OK button

from the dialogue box.

4. Move the cursor in the respective rows and columns; then

type the Time and Subjects etc.

5. Highlight the rows or columns to be shaded.

6. Select "Format" from the menu bar and then "Borders and
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Shading".

7. A dialogue box appears.

8. Select the Shading Tab, then the colour to be applied and

then click OK button.

Click Here to see a Time Table Example
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